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PRE VA©U BEZPEÈNOS« Preèítajte si tieto jednoduché pokyny. Poru¹enie 
týchto pravidiel mô¾e by» nebezpeèné alebo protizákonné. Ïal¹ie 
podrobnej¹ie informácie nájdete v osobitnej U¾ívateåskej príruèke.

BEZPEÈNOS« CESTNEJ PREMÁVKY JE NA PRVOM MIESTE Keï 
¹oférujete, nedr¾te komunikátorv ruke; v¾dy najprv zaparkujte.

RU©ENIE V¹etky bezdrôtové telefóny mô¾u podlieha» ru¹eniu, ktoré mô¾e 
zhor¹i» ich výkon.

VYPNITE TELEFÓN V NEMOCNICI Dodr¾iavajte v¹etky predpisy a pravidlá. 
Vypnite telefón v blízkosti medicínskych prístrojov.

VYPNITE TELEFÓN V LIETADLE Bezdrôtové telefóny mô¾u spôsobova» 
ru¹enie. Ich pou¾itie v lietadlách je zakázané.

VYPNITE TELEFÓN POÈAS ÈERPANIA POHONNÝCH HMÔT Nepou¾ívajte 
telefón na èerpacích staniciach. Nepou¾ívajte ho v blízkosti palív a 
chemikálií.

VYPNITE TELEFÓN V BLÍZKOSTI ODSTRELOV Nepou¾ívajte telefón tam, 
kde prebiehajú trhacie práce. Riaïte sa obmedzeniami a dodr¾iavajte v¹etky 
predpisy a pravidlá.

POU®ÍVAJTE UVÁ®LIVO Pou¾ívajte telefón iba v normálnej polohe (pri 
uchu). Nedotýkajte sa zbytoène antény.

POU®ÍVAJTE KVALIFIKOVANÝ SERVIS Zariadenie smie opravova» a 
in¹talova» iba kvalifikovaný servisný personál.



PRÍSLU©ENSTVO A BATÉRIE Po¾ívajte výluène schválené príslu¹enstvo a 
batérie. Nekombinujte nekompatibilné súèasti.

VOLANIE CEZ TELEFÓN Zatvorte kryt a skontrolujte, ¾e telefón je zapnutý 
a v prevádzke. Zadajte telefóne èíslo, vrátane predvoåby, a stlaète . Hovor 
ukonèíte stlaèením . Hovor prevezmete stlaèením .

TIESÒOVÉ VOLANIA Zatvorte kryt komunikátora. Presvedète sa, ¾e telefón 
je zapnutý a v prevádzke. Stlaète  a na niekoåko sekúnd ho pridr¾te, aby 
sa displej vymazal. Navoåte tiesòové èíslo a stlaète . Uveïte svoju 
polohu. Neukonèujte hovor, kým vám k tomu druhá strana nedá pokyn.

ZÁLOHUJTE SI DÁTA Nezabudnite si vytvori» zálo¾né kópie v¹etkých 
dôle¾itých dát.

PRIPOJENIE K INÝM ZARIADENIAM Pri pripájaní k akémukoåvek inému 
zariadeniu si v jeho návode na pou¾itie preèítajte podrobné bezpeènostné 
pokyny. Nekombinujte nekompatibilné zariadenia.

BEZPEÈNÉ POU®ÍVANIE INFRAÈERVENÉHO ®IARENIA Nemierte 
infraèerveným lúèom nikomu do oèí a nedovoåte, aby ru¹il prácu iných 
infraèervených zariadení.
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Po otvorení predajného balenia skontrolujte, ¾e sa v òom nachádzajú nasledujúce 
súèasti:
• Nokia 9210 Communicator
• Pamä»ová karta
• U¾ívateåská príruèka, Kontrolný zoznam nastavení, táto príruèka Zaèíname: 

Struèný návod, spojená s Návodom k príslu¹enstvu, a Návod na pou¾itie 
doplnkových aplikácií

• Vysokokapacitná batéria BLL-3
• Nabíjaèka ACP-9
• Kábel adaptéra DLR-2L/RS-232
• CD-ROM so softwarom pre komunikáciu s poèítaèom PC
• Nálepky s výrobným èíslom a ochranným kódom komunikátora

Pou¾itie telefónu
Tip: Ak chcete vyu¾i» on-

line pomocníka, otvorte kryt 
a stlaète tlaèidlo  
(Pomocník).

Aby ste svoj Nokia 9210 Communicator mohli pou¾íva» na volanie a príjem 
hovorov:
• ma» zapnutý telefón,
• ma» v òom vlo¾enú platnú SIM kartu a 
• nachádza» sa v mieste, obsluhovanom rádiotelefónnou sie»ou.

V niektorých sie»ach sú povolené tiesòové volania na medzinárodné tiesòové èíslo 
112 aj bez SIM karty. Overte si to u operátora svojej siete.
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Poznámka: Uchovávajte v¹etky miniatúrne SIM karty mimo dosahu malých detí.

1 Zatvorte kryt komunikátora a skontrolujte, ¾e telefón je vypnutý. Ak je zapnutý, 
stlaète .

2 Ak je ku komunkátoru pripojená batéria, snímte ju. Zatlaète úchytku v hornej 
èasti batérie a vyberte batériu z dutiny. Pozrite si Obrázok 1.

Obrázok 1

3 Zasuòte SIM kartu do ¹trbiny: dbajte na to, aby sa zlaté kontakty SIM karty 
nachádzali na spodnej strane a skosený roh karty bol napravo. Pozrite si 
Obrázok 2.
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Obrázok 2

Keï je karta správne zasunutá do ¹trbiny SIM karty, zostáva skosený roh 
viditeåný, tak ako na Obrázku 3.

Obrázok 3 skosený roh je viditeåný
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batériu. Ak je batéria temer alebo úplne vybitá, odporúèame komunikátor 
pripoji» k nabíjaèke a zaèa» nabíja» batériu, skôr ne¾ budete pokraèova» 
v uvedení komunikátora do prevádzky. 

5 Otvorte kryt komunikátora. Kým bude komunikátor preverova» svoje funkcie, 
uvidíte uvítaciu obrazovku.

6 Keï komunikátor skonèí preverovanie svojich funkcií a je podporované voliteåné 
nastavenie klávesnice, vyzve vás vybra» si správne nastavenie klávesnice. 
Stlaèením OK potvrïte výber klávesnice.
V opaènom prípade sa na displeji sa zobrazí zoznam miest.

Tip: Domovské mesto, 
èasové pásmo, formát 
dátumu a èasu mô¾ete 
neskôr zmeni» v aplikáciách 
Clock (Hodiny) a Control 
panel (Ovládací panel).

7 Pomocou navigaèného tlaèidla so ¹ípkami prejdite k názvu svojho domovského 
mesta a stlaète OK (Áno). Otvorí sa okno, ukazujúce aktuálny èas a dátum.
Názov mesta mô¾ete vyhåada» tak, ¾e zadáte re»azec pre vyhåadávanie do 
vyhåadávacieho poåa v spodnej èasti okna.

8 Ak treba, zmeòte èas a dátum a stlaète OK.

Tip: V aplikácii Contacts 
(Adresár) mô¾ete neskôr ku 
svojej vizitke prida» obrázok.

9 Ïalej mô¾ete upravi» svoje osobné údaje na vizitke. Stlaète OK (Áno).
Ak je v komunikátore vlo¾ená platná SIM karta, do vizitky sa mohli premietnu» 
niektoré údaje zo SIM karty. 

10 Objaví sa správa, potvrdzujúca, ¾e ste úspe¹ne ukonèili inicializáciu 
komunikátora. Stlaète OK (Áno).
Poznámka: Ak SIM karta nie je vlo¾ená správne, nemo¾no správne osadi» 

batériu. Nevtláèajte batériu na miesto násilím! Skontrolujte, ¾e ste 
SIM kartu vlo¾ili do ¹trbiny podåa predchádzajúceho návodu. Ak 
SIM karta nie je správne zasunutá, vyberte ju vytiahnutím zo ¹trbiny 
a znova ju zasuòte.



©2001 Nokia Mobile Phones. All rights reserved.

5

Za
èí

na
m

eNabitie batérie
Tip: Ak chcete zisti» 

aktuálny stav batérie, 
pozrite si indikátor stavu 
batérie  na displeji 
komunikátora alebo 
telefónu.

1 Zapojte káblik nabíjaèky do spodnej èasti komunikátora, ako ukazuje Obrázok 4.

Obrázok 4

2 Zapojte nabíjaèku do sie»ovej zásuvky s vhodným sie»ovým napätím. Poèas 
nabíjania indikátor stavu batérie na displeji telefónu roluje.

3 Keï je batéria úplne nabitá, stµpec prestane rolova» a ostanú zobrazené ¹tyri 
dieliky. Teraz mô¾ete odpoji» konektor nabíjaèky od komunikátora.
Poznámka: Poèas nabíjania mô¾ete komunikátor normálne pou¾íva».
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Tip: Ak prechádzate na 
Nokia 9210 Communicator 
z niektorej zo star¹ích verzií 
komunikátora Nokia, pozrite 
si kapitolu V¹eobecné 
informácie v U¾ívateåskej 
príruèke.

Obrázok 5

Hlavné prvky rozhrania komunikátora sú spolu s displejom zobrazené na Obrázku 5. 
Displej zapnete jednoducho otvorením krytu. Na displeji sa objaví aplikácia, ktorá 
bola aktívna, keï ste komunikátor naposledy pou¾ili.

Keï zavriete kryt, rozhranie komunikátora ulo¾í v¹etky dáta  a vypne svoj displej.

Poznámka: Údaje nemusíte osobitne uklada». Keï stlaèíte Close (Zavrie»), 
prepnete sa do inej aplikácie alebo zatvoríte kryt komunikátora, 
Nokia 9210 Communicator automaticky ulo¾í v¹etky dáta.

Príkazové 
tlaèidlá

Navigaèné 
tlaèidloTlaèidlo Menu

Klávesnica
Tlaèidlo Pomocník

Tlaèidlá 
aplikácií

Displej
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Tlaèidlá v hornej èasti klávesnice spú¹»ajú príslu¹né aplikácie. Sú to nasledujúce 
aplikácie: Desk (Pracovná plocha), Telephone (Telefón), Messaging (Výmena 
správ), Internet, Contacts (Adresár), Calendar (Kalendár), Office (Kancelária) a 
Extras (©peciálne aplikácie).

Tip: Be¾iace aplikácie 
mô¾ete vybera» v menu 
„Task” (Úlohy) na åavej 
strane li¹ty hlavného menu.

Ak chcete prejs» do inej aplikácie, stlaète jej tlaèidlo. To mô¾ete urobi» dokonca aj 
poèas hovoru. Keï spú¹»ate ïal¹iu aplikáciu, nemusíte ¾iadnu aplikáciu ukonèova». 
V¹etky neaktívne aplikácie zostávajú na pozadí, kým ich znova nespustíte.

Prvky displeja

Obrázok 6
Táto polo¾ka je 
vybraná

Rám na pravej strane. Stlaète 
tlaèidlo Tab, ak ho chcete zvýrazni».

Tento rám na åavej strane 
je zvýraznený

Informácie o polo¾ke 
Príkazy, ktoré 
mô¾ete pou¾i»

m
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U¾ívateåskej príruèky „stlaèi» 
Open (Otvori»),” znamená 
to, ¾e musíte stlaèi» 
príkazové tlaèidlo vedåa 
názvu príkazu Open.

Hlavné prvky displeja sú zobrazené na Obrázku 6. Príkazy sa v¾dy vz»ahujú na ¹tyri 
príkazové tlaèidlá. V návodoch sú príkazy vysádzané hrubo a polo¾ky, ktoré sa 
zobrazujú na displeji a na li¹te menu, sú vysádzané kurzívou.

Rolovacia li¹ta naznaèuje, ¾e je k dispozícii viac polo¾iek, ne¾ je ich momentálne 
zobrazených na displeji. Obraz na displeji mô¾ete posúva» pomocou navigaèného 
tlaèidla so ¹ípkami v pravom spodnom rohu klávesnice.

Keï je v spodnej èasti displeja vyhåadávacie pole, mô¾ete polo¾ky vyhåadáva» tak, 
¾e s vyu¾itím klávesnice zadáte do vyhåadávacieho poåa text.

Ak sa v okne nachádza viac ne¾ jeden rám, je vybraný rám v¾dy zvýraznený.

Pomocou navigaèného tlaèidla sa vo vybranom ráme sa mô¾ete pohybova» a 
vybera» polo¾ky.

Stlaèením tlaèidla Menu získate prístup k príkazom menu.

Konfigurácia nastavení
Aby ste mohli pristupova» k Internetu, slu¾bám WAP a svojej vzdialenej po¹tovej 
schránke, musíte nakonfigurova» príslu¹né nastavenia. 

Poznámka: Pri konfigurovaní týchto nastavení vám pomô¾e Kontrolný zoznam 
nastavení, ktorý nájdete v predajnom balení komunikátora. Z neho 
uvidíte, aké údaje potrebujete, odkiaå ich mo¾no získa», a kam ich 
zada» do komunikátora. Je dôle¾ité, aby ste si tieto údaje zapísali do 
kontrolného zoznamu, kde ich v prípade potreby kedykoåvek åahko 
nájdete. Kontrolný zoznam mô¾ete pou¾i» pri komunikácii 
s poskytovateåmi slu¾ieb o údajoch, ktoré od nich potrebujete 
získa».
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2 Pomocou navigaèného tlaèidla vyberte ikonu Internet startup (Slu¾by Internetu) 

a stlaète Open (Otvori»). Objavia sa tri ikony: Internet access (Prístup na 
Internet), WAP access (Prístup na WAP) a Mail account (Po¹tové konto).

Tip: Podrobnej¹ie 
informácie nájdete 
v kapitole ©peciálne 
aplikácie - Extras 
v U¾ívateåskej príruèke.

3 Vyberte Internet access (Prístup na Internet) a stlaète Open (Otvori»). Otvorí sa 
dialógové okno.

Obrázok 7

Tip: Vysvetlenie 
k informáciám, ktoré je 
potrebné zada» v tomto a 
v nasledujúcom dialógovom 
okne, získate stlaèením 
tlaèidla on-line pomocníka 

 na klávesnici; pozrite si 
tie¾ U¾ívateåskú príruèku.

4 Zadajte príslu¹né údaje a stlaète Advanced settings (Roz¹írené nastavenia). 
Otvorí sa dialógové okno so ¹tyrmi kartami.
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mô¾ete prechádza» 
stláèaním tlaèidla Menu.

Obrázok 8

Na ka¾dej karte zadajte príslu¹né údaje. 
Na karte Other (Ïal¹ie) stlaète Address options (Nastavenie adries). Otvorí sa 
dialógové okno.

Obrázok 9

Tu mô¾ete definova» IP adresu a adresu DNS.
Stlaèením Done (Hotovo) sa vrátite k obrazovke s troma ikonami.

Tip: Podrobnej¹ie 
informácie nájdete 
v kapitole Internet 
v U¾ívateåskej príruèke.

5 Vyberte WAP access (Prístup na WAP) a stlaète Open (Otvori»). Otvorí sa 
dialógové okno.
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Obrázok 10

Na ka¾dej karte zadajte príslu¹né informácie a vrá»te sa k obrazovke s troma 
ikonami stlaèením Close.

Tip: Podrobnej¹ie 
informácie nájdete 
v kapitole Výmena správ - 
Messaging v U¾ívateåskej 
príruèke.

6 Vyberte Mail account (Po¹tové konto) a stlaète Open (Otvori»). Otvorí sa 
dialógové okno so ¹tyrmi kartami.

Obrázok 11

Na ka¾dej karte zadajte príslu¹né informácie a vrá»te sa k obrazovke s troma 
ikonami stlaèením Done (Zavrie»).



©2001 Nokia Mobile Phones. All rights reserved. 

12
Za

èí
na

m
e Prepojenie s poèítaèom

Svoj komunikátor mô¾ete prepoji» s kompatibilným poèítaèom PC alebo prenosným 
poèítaèom pomocou programu PC Suite for Nokia 9210 Communicator, ktorý sa 
nachádza na disku CD-ROM, dodávanom v predajnom balení. Tento disk CD-ROM 
obsahuje v èasti Using Nokia 9210 Communicator (Pou¾ívame Nokia 9210 
Communicator) aj návod k programu PC Suite - PC Suite Guide.

Program PC Suite for Nokia 9210 Communicator pracuje pod systémami Windows 
95/98, 2000 a NT. Tento program integruje súborový systém komunikátora do 
súborového systému vá¹ho poèítaèa, a tak vám umo¾òuje rýchlo presúva», 
kopírova», premenúva» a vymazáva» súbory a zlo¾ky súborov na komunikátore a 
medzi komunikátorom a poèítaèom.

Pomocou programu PC Suite mô¾ete synchronizova» dáta aplikácií, napríklad 
kontakty a elektronickú po¹tu medzi komunikátorom a va¹ím poèítaèom, a mô¾ete 
tie¾ zálohova» dáta na poèítaèi. Synchronizáciu a zálohovanie mô¾ete aj 
automatizova», aby sa vykonávali vo vopred urèených èasoch alebo pri prepojení.

Program PC Suite mô¾ete pou¾íva» aj vtedy, keï poèítaè nie je pripojený ku 
komunikátoru (re¾im off-line). Keï najbli¾¹ie prepojíte obe zariadenia, informácie, 
zmenené na va¹om poèítaèi, sa budú aktualizova» v komunikátore a naopak.

VAROVANIE! Dajte si pozor na vírusy. Na komunikátor in¹talujte iba software, 
ktorý ste získali zo zdrojov poskytujúcich adekvátnu ochranu 
proti vírusom. Pozrite si èas» „Správa osvedèení” v U¾ívateåskej 
príruèke.
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1 Ak pou¾ívate kábel, zapojte väè¹iu koncovku kábla RS-232 do sériového (COM) 

portu poèítaèa a men¹iu koncovku do konektora na spodnej èasti komunikátora. 
2 Ak pou¾ijete infraèervený port alebo sériový port iný ne¾ COM1, kliknite dvakrát 

na pripojovaciu ikonu programu PC Suite na li¹te úlohy Windows a vyberte pre 
prepojenie správny port.

3 Otvorte komunikátor.
4 Ak pou¾ívate infraèervené prepojenie, presvedète sa, ¾e infraèervený port 

komunikátora sa nachádza oproti infraèervenému portu poèítaèa. Stlaèením 
Chr +  (tlaèidlo so symbolom IÈ prepojenia) aktivujete infraèervené 
prepojenie na va¹om komunikátore. Viac informácií o aktivácii infraèerveného 
portu na komunikátore nájdete v U¾ívateåskej príruèke.

5 Spustite na poèítaèi program PC Suite. 
Program PC Suite by mal teraz automaticky vytvori» prepojenie 
s komunikátorom.

Pracovná plocha - Desk
Skupina aplikácií Desk (Pracovná plocha) slú¾i pre prácu s rozliènými odkazmi na 
èasto pou¾ívané aplikácie alebo software od tretích výrobcov, a na vyu¾ívanie 
týchto odkazov. Odkazy mô¾ete vytvára» v príslu¹ných aplikáciách.

Vytvorenie nového odkazu
1 Otvorte objekt v príslu¹nej aplikácii. 
2 Stlaète tlaèidlo Menu a vyberte Add to Desk (Prida» na pracovnú plochu).
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1 Stlaète Write note (Napísa» poznámku). Otvorí sa jednoduchý textový editor.
2 Napí¹te poznámku.
3 Stlaèením Close (Zavrie») dokument ulo¾te. Poznámka sa teraz objaví 

v hlavnom okne Pracovnej plochy.

Telefón - Telephone
Aplikácia Telephone sa pou¾íva na volanie a prijímanie hlasových hovorov a úpravu 
nastavení telefónu. Aplikáciu spustíte tak, ¾e otvoríte kryt komunikátora a stlaèíte 
tlaèidlo Tel na klávesnici. Mnoho z toho, èo mô¾ete urobi» v aplikácii Telephone, 
mô¾ete takisto urobi» s vyu¾itím predného krytu komunikátora.

Ak chcete telefonova», 
• musíte ma» zapnutý telefón,
• v komunikátore sa musí nachádza» platná SIM karta a 
• musíte sa nachádza» v mieste, obsluhovanom rádiotelefónnou sie»ou.

Volanie
Vola» mô¾ete dvoma spôsobmi:
• Vyberte kontakt zo zoznamu aplikácie Telephone a stlaète Call (Vola»). Ak má 

vybraný kontakt iba jedno telefónne èíslo, komunikátor toto èíslo ihneï zavolá.
Ak má kontakt niekoåko telefónnych èísel, otvorí sa zoznam telefónnych èísel. 
Vyberte zo zoznamu èíslo a stlaète Call (Vola»).

• Zadajte telefónne èíslo do vyhåadávacieho poåa v spodnej èasti hlavného okna 
a stlaète Call (Vola»).
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ePrijatie hovoru
Prichádzajúci hovor oznamuje správa na displeji. Mô¾ete tie¾ poèu» vyzváòací tón. 
Hovor prijmete stlaèením Answer (Odpoveda»), alebo, ak hovor nechcete prija», 
stlaète Reject (Odmietnu»).

Re¾im Lietadlo - Flight profile

Re¾im Lietadlo zabraòuje náhodnému zapnutiu telefónu v lietadle. Ak chcete 
aktivova» re¾im Lietadlo:
1 V hlavnom okne aplikácie Telephone stlaète tlaèidlo Menu, prejdite li¹tou menu 

k ikone Profiles  (Re¾imy) a potom zvýraznite Flight (Lietadlo).
2 Stlaète Select (Vybra»).

Keï je aktívny re¾im Lietadlo, mô¾ete na komunikátore vykonáva» iba èinnosti, 
ktoré si nevy¾adujú komunikáciu s rádiotelefónnou sie»ou. Napríklad si mô¾ete 
èíta» po¹tu, ktorú ste predtým prijali, písa» správy do po¹ty, poznámky, krátke 
správy, faxy, alebo aktualizova» svoj kalendár. Po opustení lietadla vypnite re¾im 
Lietadlo stlaèením Exit profile (Vypnú» re¾im) v aplikácii Telefón. Potom mô¾ete 
stlaèením  zapnú» telefón, a va¹e krátke správy, faxy a po¹ta sa automaticky 
odo¹lú.

Keï je komunikátor v re¾ime Lietadlo, musia sa tiesòové hovory uskutoèòova» 
z telefónu (zavrite kryt komunikátora):
1 Stlaète . Na displeji telefónu sa objaví správa Flight profile is active. (Je aktívny 

re¾im Lietadlo).
2 Kým je zobrazená táto správa (asi na pä» sekúnd), mô¾ete navoli» tiesòové èíslo, 

naprogramované vo va¹om komunikátore, napríklad 112.
3 Stlaète .
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e DÔLE®ITÉ! Nikdy nepou¾ívajte telefón v lietadle. Ak vám posádka lietadla 

dovolí pou¾íva» rozhranie komunikátora, MUSÍTE aktivova» re¾im 
Lietadlo. Re¾im Lietadlo vám dovolí pou¾íva» iba rozhranie 
komunikátora a zabráni pou¾itiu telefónu. Nezabudnite, ¾e v¹etky 
komunikaèné aplikácie si vy¾adujú pou¾itie telefónu.

Výmena správ - Messaging
Messaging (Výmena správ) obsahuje nasledujúce aplikácie: Fax, Mail (Elektronická 
po¹ta) a SMS (Slu¾ba krátkych textových správ). Aplikáciu Messaging spustíte 
stlaèením tlaèidla Messaging na klávesnici.

Odosielanie a prijímanie faxov, správ elektronickej po¹ty a krátkych správ
• musíte ma» zapnutý telefón,
• sie», ktorú pou¾ívate, musí podporova» faxové prenosy, dátové prenosy a slu¾by 

SMS,
• na va¹ej SIM karte musia by» aktivované slu¾by faxových a dátových prenosov 

a SMS,
• od poskytovateåa slu¾ieb Internetu musíte ma» údaje o prístupovom mieste 

k Internetu (Internet Access Point - IAP) a musíte ma» zadané príslu¹né 
nastavenia pre Internet a elektronickú po¹tu,

• v nastaveniach aplikácie SMS musíte ma» ulo¾ené èíslo centra SMS správ.

Podrobnosti si zistite od svojho domovského poskytovateåa slu¾ieb.

Poznámka: Systém elektronickej po¹ty Nokia 9210 Communicatora podporuje 
internetové ¹tandardy SMTP, IMAP4 a POP3.
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ePísanie a odosielanie faxov, správ elektronickej 
po¹ty a krátkych správ
Faxy, správy elektronickej po¹ty a krátke správy mô¾ete písa», upravova» a odosiela» 
z príslu¹ných editorov, do ktorých mô¾ete vstúpi» jedným z troch nasledujúcich 
spôsobov: 
• Napí¹te a sformátujte text v ktorejkoåvek aplikácii komunikátora, ktorá to 

umo¾òuje. Keï chcete text odosla», stlaète tlaèidlo Menu, vyberte File > Send 
(Súbor/Odosla») a vyberte zo submenu jednu z volieb odosielania. 

• V hlavnom okne aplikácie Messaging stlaète jeden z nasledujúcich príkazov: 
Write fax (Napísa» fax), Write mail (Napísa» správu el. po¹ty), Write short 
message (Napísa» krátku správu).

• V hlavnom okne aplikácie Messaging stlaète tlaèidlo Menu a vyberte Write > 
New message… (Písa»/Novú správu…). Potom vyberte po¾adovaný typ správy.

Výber adresátov

Poznámka: Fax mô¾e ma» iba jedného adresáta.

Adresátov faxu, správy elektronickej po¹ty alebo krátkej správy mô¾ete vybra» 
dvoma spôsobmi:
1 V príslu¹nom editore správy stlaète Recipient (Adresát). Otvorí sa dialógové 

okno so zoznamom va¹ich kontaktov.
2 V åavom ráme vyhåadajte kontakt alebo viac kontaktov a stlaète Select (Vybra»).
3 Stlaète Done (Hotovo).

Mô¾ete tie¾ napísa» meno adresáta do hlavièky faxu, správy elektronickej po¹ty 
alebo krátkej správy a skontrolova» ho podåa databázy kontaktov.
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Faxy sa prijímajú automaticky, pravda¾e len ak je táto slu¾ba dostupná a telefón je 
zapnutý a nachádza sa v dosahu rádiotelefónnej siete. Krátke správy sa prijímajú 
automaticky, ak je vá¹ telefón zapnutý.

Prijatý fax alebo krátku správu si mô¾ete preèíta» dvoma spôsobmi:
• Ak vidíte na displeji upozornenie na prijatý fax alebo krátku správu, alebo ak 

poèujete príslu¹né zvukové upozornenie, stlaète Open (Otvori»). Zvukové 
upozornenie zaznie iba za istých podmienok.

• Prejdite do aplikácie Messaging (Výmena správ). V prieèinku Inbox (Prijaté) 
vyberte novú správu/fax a stlaète Open (Otvori»). Fax alebo krátka správa sa 
otvorí v príslu¹nom prehliadaèi.

Preberanie a èítanie správ elektronickej po¹ty
Správy elektronickej po¹ty, ktoré sú vám adresované, neprichádzajú automaticky 
na vá¹ komunikátor, ale do vzdialenej po¹tovej schránky. Ak si chcete doruèenú 
po¹tu preèíta», musíte sa najskôr pripoji» ku vzdialenej po¹tovej schránke a potom 
vybra» správy, ktoré chcete prevzia» do komunikátora. Spojenie so vzdialenou 
schránkou sa uskutoèòuje ako dátový prenos.

Pripojenie ku vzdialenej po¹tovej schránke

1 Vyberte si vzdialenú po¹tovú schránku v åavom ráme hlavného okna aplikácie 
Messaging (Výmena správ).

2 Vyberte pravý rám a stlaète Retrieve mail (Prevzia» po¹tu). 
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e3 Po vytvorení spojenia so vzdialenou po¹tovou schránkou stlaète tlaèidlo Menu 
a vyberte Retrieve (Prevzia») > New (Nové) alebo Selected (Vybrané) alebo All 
(V¹etky) po¹tové správy.

4 Po prevzatí v¹etkých správ, ktoré ste si vy¾iadali, stlaète Go offline (Odpoji»).
5 Vyberte správu, ktorú si chcete preèíta», a stlaète Open (Otvori»).

Internet
Aby ste mohli pristupova» k Internetu, 
• musí rádiotelefónna sie», ktorú pou¾ívate, podporova» dátové prenosy,
• pre va¹u SIM kartu musí by» aktivovaná slu¾ba dátových prenosov,
• musíte ma» od poskytovateåa slu¾ieb Internetu (Internet Service Provider - ISP) 

pridelené prístupové miesto k Internetu (Internet Access Point - IAP) a
• musíte ma» zadané príslu¹né nastavenia pre prístup k Internetu. Riaïte sa 

pokynmi v U¾ívateåskej príruèke. Pre zaznamenanie svojich nastavení pou¾ite 
kartu Kontrolný zoznam nastavení, ktorú nájdete v predajnom balení.

Vá¹ ISP vás pouèí, ako nakonfigurova» nastavenia Internetu. Pozorne sa riaïte jeho 
pokynmi.

Poznámka: Aby ste sa mohli pripoji» na Internet, musíte ma» zapnutý telefón, 
nachádza» sa v dosahu siete a nesmiete ma» na telefóne iný hovor 
alebo dátový prenos.

Ak sa chcete pripoji» na Internet, postupujte takto:
1 Stlaète tlaèidlo aplikácie Internet na klávesnici komunikátora.
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aplikácia potrebuje vytvori» pripojenie, otvorí sa dialógové okno, zobrazujúce 
Connection name (Názov pripojenia) a Phone number (Telefónne èíslo) 
prístupového miesta k Internetu, ktoré sa pou¾ije pre vytvorenie pripojenia. 

3 Stlaèením OK (Áno) vytvoríte pripojenie.
4 Aplikáciu ukonèíte stlaèením Done (Hotovo).
5 Ak sa chcete v ktorejkoåvek internetovej aplikácii odpoji» od Internetu, stlaète 

tlaèidlo Internet na klávesnici a potom stlaète Disconnect (Odpoji»). Odpojenie 
sa uskutoèní okam¾ite.

Prehliadaè World Wide Web (WWW)
WWW je hypertextový systém, slú¾iaci na vyhåadávanie a prístup k zdrojom 
Internetu. Pohyb po World Wide Web:

Príklad: Príklad URL adresy: 
www.nokia.com.

Tip: Niektoré miesta na 
Webe vy¾adujú, aby ste 
zadali svoje u¾ívateåské 
meno a heslo, a a¾ potom 
vám sprístupnia príslu¹nú 
WWW stránku. U¾ívateåské 
meno a heslo sa ulo¾ia a 
pou¾ijú sa, keï budete 
chcie» toto miesto znova 
nav¹tívi». 

1 Stlaète tlaèidlo Menu a vyberte File > Open > Web page… (Súbor/Otvori»/WWW 
stránku…).

2 Zadajte URL adresu do poåa Address, alebo vyberte niektorú zálo¾ku zo zoznamu 
zálo¾iek a stlaète Go to (Prejs» na). Na iné miesta mô¾ete prejs» aj z úvodnej 
stránky vá¹ho WWW prehliadaèa.

3 Po naèítaní a otvorení stránky mô¾ete vybera» linky alebo klikacie polia 
pomocou klávesu Tab. Pre pohyb spä» pou¾ite kombináciu Shift+Tab. Mô¾ete 
pou¾i» aj nástroj Ukazovátko (Pointer); mô¾ete ho aktivova» kombináciou 
Ctrl + Q. Viac informácii o nástroji Ukazovátko nájdete v U¾ívateåskej príruèke.

4 Ak chcete prejs» na inú stránku alebo miesto, vyberte odkaz alebo klikaciu 
oblas» a stlaète Go to (Prejs» na).
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Aplikácia WAP services (Slu¾by WAP) je hypertextový systém, ktorý sa pou¾íva na 
prístup k slu¾bám Internetu, ponúkajúcim správy, informácie o poèasí, letové 
poriadky, slovníky a ïal¹ie informácie. Je prispôsobený potrebám a mo¾nostiam 
mobilných u¾ívateåov, vyu¾ívajúcich mobilné zariadenia.

Ak chcete získa» prístup k slu¾bám WAP: 
• musíte sa nachádza» v dosahu siete, podporujúcej dátové prenosy,
• pre va¹u SIM kartu musí by» aktivovaná slu¾ba dátových prenosov,
• od poskytovateåa slu¾ieb WAP musíte ma» pridelený prístupový bod WAP, a
• musíte ma» zadané príslu¹né nastavenia pre prístup k WAPu. Riaïte sa pokynmi 

v U¾ívateåskej príruèke.

Ako prechádza» slu¾bami WAP

Ak chcete otvori» WAP stránku:
1 Stlaète tlaèidlo Menu a vyberte File > Open page (Súbor/Otvori» stránku). Otvorí 

sa dialógové okno. Zadajte URL adresu, napríklad: mobile.club.nokia.com.
2 Pomocou navigaèného tlaèidla mô¾ete prechádza» oknom a vybera» odkazy a 

klikacie oblasti.
Poznámka: Niektoré servery majú prístupové obmedzenia a vy¾adujú zadanie 

platného mena u¾ívateåa a hesla. V takomto prípade si od vás 
prehliadaè vy¾iada meno u¾ívateåa a heslo, aby mohol vytvori» 
spojenie so slu¾bou.
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Adresár Contacts spustíte stlaèením tlaèidla Contacts na klávesnici. Adresár 
mô¾ete vyu¾íva» na uchovávanie, úpravu a prácu s kontaktnými informáciami, ako 
sú telefónne èísla a adresy. Záznamy v adresári Contacts sa nazývajú karty adresára 
(contact cards). Svoj adresár mô¾ete synchronizova» s kompatibilným 
poèítaèom PC.

Hlavná databáza kontaktov sa nachádza v pamäti komunikátora. Adresár mô¾ete 
uchováva» aj v osobitnej databáze alebo na pripojenej pamä»ovej karte.

Vytvorenie karty adresára
1 V hlavnom okne adresára Contacts stlaète New card (Nová karta).
2 Keï sa otvorí karta adresára, zadajte do jednotlivých polí príslu¹né údaje.
3 Kartu adresára ulo¾íte stlaèením Done (Hotovo).

Ak chcete kontaktu zatelefónova»:
Hlavné okno adresára Contacts pozostáva z dvoch rámov, åavého a pravého. Stlaète 
kláves tabulátora (Tab), aby ste sa presunuli do pravého rámu. Zvýraznite telefónne 
èíslo kontaktu a stlaète Call (Vola»).
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V aplikácii Calendar si mô¾ete skontrolova» naplánované udalosti, stretnutia, 
výroèia, narodeniny, ako aj zobrazi» zoznam úloh, ktoré máte splni». Pre v¹etky 
záznamy v kalendári mô¾ete nastavi» zvukové upozornenie. Aplikáciu Calendar 
spustíte stlaèením tlaèidla Calendar na klávesnici komunikátora.

Po pripojení komunikátora ku kompatibilnému poèítaèu PC mô¾ete svoj kalendár a 
úlohy synchronizova» s programami Microsoft Windows a Lotus.

Pridanie záznamu do kalendára
Jedna z mo¾ností, ako vytvori» nový záznam v kalendári, je táto:
1 Stlaète tlaèidlo Menu a vyberte File > New entry (Súbor/Nový záznam). Vyberte 

záznam, ktorý chcete vytvori»: Appointment… (Stretnutie…), Event… (Udalos»…), 
Anniversary… (Výroèie…) alebo Task… (Úloha…).

2 Do polí na jednotlivých stránkach dialógového okna zadajte príslu¹né údaje.

Mesaèný prehåad - Month view
Mesaèný prehåad je hlavné zobrazenie kalendára. Ak ste do kalendára zadali údaje 
pre niektorý mesiac, zobrazí sa na pravej strane displeja zoznam udalostí. Ak chcete 
upravi» udalos»:
1 Stlaèením klávesu Enter alebo Edit day (Upravi» deò) zvýraznite rám na pravej 

strane.
2 Vyberte udalos» a stlaète Edit (Upravi»). Otvorí sa formulár s podrobnými údajmi 

o zázname.
3 Podåa potreby zmeòte údaje o zázname.
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Tý¾denný prehåad zobrazuje èasový plán na vybraný tý¾deò. Ak si chcete prezrie» 
tý¾denný prehåad, stlaète Change view (Zobrazi» inak) a vyberte Week (Tý¾deò).

Denný prehåad - Day view
Denný prehåad zobrazuje záznamy pre vybraný deò. Denný prehåad otvoríte tak, ¾e 
stlaèíte Change view (Zobrazi» inak) a vyberiete Day (Deò). 

Prehåad úloh - Tasks lists
Prehåad úloh postupne zobrazuje jednotlivé zoznamy úloh. Aplikáciu mô¾ete pou¾i» 
na vytváranie zoznamov úloh a organizovanie úloh. Pre jednotlivé úlohy mô¾ete 
nastavi» dátumy splnenia a priority. Mô¾ete si vies» aj niekoåko zoznamov úloh, 
napríklad jeden pre pracovné úlohy a ïal¹í pre súkromné úlohy. 

Ïal¹ie prehåady
Komunikátor obsahuje aj ïal¹ie prehåady, napríklad Celoroèný prehåad (Year 
schedule) a Prehåad výroèí (Anniversaries view).

Kancelária - Office
Skupina kancelárskych aplikácií Office obsahuje nasledujúce aplikácie: Textový 
procesor Word, tabuåkový procesor Sheet, prezeraè prezentácií Presentation viewer 
a súborový mana¾ér File manager, ktoré sú v¹etky kompatibilné s Microsoft 
Windows.
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eVytvorenie dokumentu programu Word
Keï otvoríte aplikáciu Word, otvorí sa nový dokument. Mô¾ete hneï zaèa» písa».

Dokument ulo¾íte stlaèením Close (Zavrie»). Otvorí sa dialógové okno. Dokument 
musíte teraz pomenova» a vybra» zlo¾ku, do ktorej ho chcete ulo¾i».

Tabuåkový kalkulátor  Sheet
V kalkulátore Sheet mô¾ete pracova» s dátami a uklada» ich do súborov, ktoré sa 
nazývajú zo¹ity (workbook). Ka¾dý zo¹it obsahuje najmenej jeden list (worksheet). 
Zo¹it mô¾e popritom obsahova» aj listy s grafmi. List s grafom (chartsheet) je 
dokument, obsahujúci graf zostrojený z dát na niektorom liste.

Vytvorenie zo¹itu a listov

Tip: Ak chcete vytvori» 
nový zo¹it na Pracovnej 
ploche (Desk), stlaète 
tlaèidlo Menu a vyberte File 
> Add to Desk (Súbor/Prida» 
na pracovnú plochu).

Nový zo¹it vytvoríte tak, ¾e stlaèíte tlaèidlo Menu a vyberiete File > New workbook 
(Súbor/Nový zo¹it).

Zo¹it ulo¾íte tak, ¾e v okne zo¹ita stlaèíte tlaèidlo Menu a vyberiete File > Save 
(Súbor/Ulo¾i»).

Nový list v pracovnom zo¹ite vytvoríte tak, ¾e stlaèíte tlaèidlo Menu a vyberiete 
Insert > New worksheet (Vlo¾i»/Nový list).

Ak chcete vlo¾i» do niektorej bunky dáta, vyberte bunku navigaèným tlaèidlom a 
zapí¹te do nej príslu¹ný údaj.

Vlo¾enie dát do bunky potvrïte stlaèením Enter, OK (Áno), alebo prejdite pomocou 
navigaèného tlaèidla k ïal¹ej bunke. Akciu zru¹íte stlaèením Esc alebo Cancel 
(Zru¹i»).
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Function (Funkcia). Mô¾ete zvoli» jednu z nasledujúcich kategórií: All (V¹etky), 
Financial (Finanèné), Date and time (Dátum a èas), Mathematical (Matematické), 
Statistical (©tatistické), Lookup (Vyhåadávacie), Text (Textové), Logical (Logické) a 
Information (Informaèné). Ka¾dá kategória má súbor funkcií, ktoré sú zobrazené 
v zozname pri Function name (Názov funkcie).

Vytvorenie listu s grafom

Program podporuje sedem druhov grafov: Column (Stµpcový), Stacked column 
(Skupinový stµpcový), Line (Èiarový), Pie (Výsekový), Bar (Pruhový), Stacked bar 
(Skupinový pruhový) a X/Y scatter (XY bodový).
1 Vyberte oblas» buniek na liste. Z nich sa získajú dáta pre nový list s grafom.
2 Stlaète tlaèidlo Menu a vyberte Insert > New chart (Vlo¾i»/Nový graf). Otvorí sa 

dialógové okno.
3 Definujte: Chart name (Názov grafu), Chart type (Typ grafu), 3-D (èi má ís» o 3-D 

graf), Background colour (Farba pozadia) a Axis colour (Farba osí).
4 Po stlaèení Close (Zavrie») sa vytvorí nový list s grafom; ak stlaèíte Cancel 

(Zru¹i»), vytvorenie grafu sa stornuje.

Prehliadaè prezentácií - Presentation viewer
Prezentáciu otvoríte stlaèením Open v hlavnom okne Presentation, a potom 
vyberiete a zobrazíte dokument. Aplikáciu ukonèíte stlaèením Close (Zavrie»).
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prezentácie si mô¾ete 
uåahèi» nastavením 
vhodného zväè¹enia 
zobrazenia.

Keï otvoríte dokument, zobrazí sa horná èas» prvého snímku. K ïal¹iemu snímku 
prejdete stlaèením Next (Ïal¹í) alebo Enter. K predchádzajúcemu snímku sa vrátite 
stlaèením Previous (Predchádzajúci). Zobrazený snímok mô¾ete posúva» pomocou 
navigaèného tlaèidla.

Správca súborov - File manager
Správcu súborov mô¾ete pou¾i» na správu obsahu a vlastností jednotlivých zlo¾iek.

Strom v ráme zlo¾iek mô¾e obsahova» zlo¾ky, patriace do dvoch koreòových 
zlo¾iek, ktorými sú komunikátor a pamä»ová karta.

V koreòovej zlo¾ke komunikátora sa nachádza zlo¾ka \Documents\ (Dokumenty), 
ktorá obsahuje ¹tyri ¹tandardné zlo¾ky: \Documents\Downloaded\ (Naèítané), 
\Documents\Photo gallery\ (Galéria fotografií), \Documents\Templates\ (©ablóny) a 
\Documents\Tones\ (Tóny).

V zozname v ráme súborov sa zobrazujú v¹etky súbory, ktoré sa na¹li na zdroji alebo 
v zlo¾ke, vybranej v åavom ráme. Záhlavie rámu zoznamu súborov ukazuje cestu k 
práve vybranému súboru. V ráme zoznamu súborov sú zobrazené aj ikony podåa 
priradených aplikácií a názvy a dátumy poslednej zmeny súborov. Súbory sú 
usporiadané v abecednom poradí.

Prezeranie obsahu zlo¾iek

1 Vyberte zlo¾ku v strome zlo¾iek v åavom ráme a stlaète Open (Otvori»). 
Zobrazí sa okno so v¹etkými zlo¾kami a súbormi, ktoré sa nachádzajú vo 
vybranej zlo¾ke.

2 Ak si chcete prezrie» ktorúkoåvek zo zobrazených zlo¾iek, vyberte ju a stlaète 
Open (Otvori»).

3 Stlaèením Done (Hotovo) sa vrátite do hlavného okna.
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1 Vyberte súbor a stlaète Open (Otvori»). Súbor sa potom otvorí v príslu¹nej 
aplikácii. 

2 Do hlavného okna sa vrátite stlaèením Close folder (Zavrie» zlo¾ku).

Vytvorenie novej zlo¾ky

1 V hlavnom okne Správcu súborov stlaète tlaèidlo Menu a vyberte File > New 
folder (Súbor/Nová zlo¾ka). Otvorí sa dialógové okno. 

2 Dajte novej zlo¾ke meno.

Vyhåadávanie súborov a zlo¾iek

1 Vyberte zlo¾ku alebo pamä»ovú oblas», kde sa má vyhåadávanie uskutoèni». 
2 Stlaète tlaèidlo Menu, > Tools > Find… (Nástroje/Vyhåada»…). Otvorí sa 

dialógové okno. 
3 Do poåa zadajte re»azec, ktorý sa má vyhåada». 
4 Ak chcete definova» podrobnej¹ie parametre vyhåadávania, stlaète Options 

(Mo¾nosti).
Stlaète Change (Zmeni»), ak chcete zmeni» hodnotu polo¾ky v zozname. 
Po dokonèení stlaète Close (Zavrie»).

5 Stlaèením Find (Håada») spustíte vyhåadávanie.
Vyhåadávanie mô¾ete preru¹i» stlaèením Stop (Zastavi»).

6 Po skonèení vyhåadávania mô¾ete stlaèením Open otvori» nájdenú zlo¾ku alebo 
súbor.
Ak chcete spusti» nové vyhåadávanie, stlaète New find (Nové håadanie).

7 Do hlavného okna sa vrátite stlaèením Close (Zavrie»).
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Ikony ¹peciálnych aplikácií sa zobrazia po stlaèení tlaèidla Extras na klávesnici 
komunikátora. Ktorúkoåvek z aplikácií spustíte tak, ¾e navigaèným tlaèidlom 
prejdete na príslu¹nú ikonu a stlaèíte Open (Otvori»). 

Ïal¹ie aplikácie mô¾ete nain¹talova» z disku CD-ROM, ktorý sa nachádza 
v predajnom balení.

Hodiny - Clock
Hodiny zobrazujú èas a dátum vo va¹om domovskom meste a krajine, ako aj 
v niekoåkých ïal¹ích mestách a krajinách sveta. Hodiny sú navy¹e vybavené aj 
budíkom.

Nastavenie  budíka

Tip: Zvukové 
upozornenia na udalosti, 
zaznamenané v kalendári, 
mô¾ete nastavi» v aplikácii 
Calendar.

1 V hlavnom okne aplikácie Clock stlaète Alarm clock (Budík). Otvorí sa okno 
budíka.
Zoznam aktívnych zvukových upozornení sa zobrazí vedåa hodín.

2 Ak chcete nastavi» ïal¹ie zvukové upozornenie, stlaète New alarm (Nové 
upozornenie).
Ak chcete niektoré zvukové upozornenie upravi», stlaète Edit alarm (Upravi» 
upozornenie).
Otvorí sa dialógové okno.

3 Definujte parametre zvukového upozornenia, napríklad Time (Èas).
4 Stlaèením Close (Zavrie») potvrïte nastavenie.
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Stlaète Stop (Zastavi») alebo ktorékoåvek tlaèidlo na klávesnici telefónu.

Ak chcete zvonenie budíka na nastavenú dobu stí¹i», stlaète Snooze (Spánok).

Kalkulaèka - Calculator
Kalkulaèka má dva re¾imy: re¾im stolovej kalkulaèky pre jednoduché aritmetické 
operácie a re¾im vedeckej kalkulaèky pre zlo¾itej¹ie matematické výpoèty.

Výpoèty mô¾ete vykonáva» dvoma spôsobmi: buï tak, ¾e zadávate znaky do 
vstupného poåa alebo tak, ¾e vyberáte symboly z mapy funkcií. Výpoèet sa vykoná 
po stlaèení Enter alebo =. Výpoèet a jeho výsledok sa zobrazuje na výstupnom liste 
na åavej strane displeja. Pre pohyb medzi vstupným poåom, výstupným listom a 
mapou funkcií mô¾ete pou¾i» tabulátor (kláves Tab) alebo mô¾ete stlaèi» Change 
focus (Presunú»).

Ovládací panel - Control panel
Ovládací panel umo¾òuje prezeranie a úpravu nasledujúcich skupín nastavení: 
Display (Obrazovka), Date and time (Dátum a èas), Regional settings (Miestne 
nastavenia), Internet access (Prístup na Internet), Profiles (Re¾imy), Security 
(Bezpeènos»), Certificate manager (Správca osvedèení), Install/Remove software 
(In¹talova»/Odstráni» programy), Default folder (©tandardná zlo¾ka), Memory 
(Pamä») a About product (O výrobku).

Úpravy týchto nastavení ovplyvòujú správanie komunikátora vo v¹etkých 
aplikáciách.
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tlaèidlom a stlaète Open (Otvori»).

Diktafón - Recorder
Tip: Pomocou diktafónu 

mô¾ete zaznamenáva» zvuky 
a reè a nastavova» ich ako 
tóny zvonenia. Podrobnej¹ie 
informácie nájdete 
v U¾ívateåskej príruèke.

Diktafón (Recorder) vám umo¾òuje zaznamenáva» telefonické hovory a hlasové 
poznámky. Mô¾ete si tie¾ vypoèu» a upravi» vlastné záznamy a ïal¹ie zvukové 
súbory.

Telefón - Phone

Obrázok 12

Telefón

Slúchadlo

Predná strana Zadná strana

Mikrofón
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1 Zatvorte kryt komunikátora, ak je otvorený.
2 Stlaèením a pridr¾aním  telefón zapnite. 

Ak vás telefón vyzve zada» PIN kód, zadajte svoj PIN kód, ktorý ste dostali spolu so 
SIM kartou, a stlaète tlaèidlo , ktoré sa nachádza priamo pod textom „OK” 
(Áno) na displeji. 

DÔLE®ITÉ! Nezapínajte telefón tam, kde je zakázané pou¾íva» bezdrôtové 
telefóny, alebo tam, kde ich pou¾itie mô¾e spôsobova» ru¹enie, 
prípadne nebezpeèenstvo.

Indikátory na displeji
Indikátory na displeji vás informujú o prevádzkovom stave telefónu. Nasledujúce 
indikátory sa zobrazujú, keï je telefón pripravený na pou¾itie a u¾ívateå nezadal na 
displej ¾iadne znaky.

NÁZOV SIETE alebo LOGO 

- Informuje, v ktorej rádiotelefónnej sieti sa telefón práve pou¾íva.

 a dieliky nad týmto symbolom.

- Udáva intenzitu signálu v mieste, kde sa nachádzate. Èím viac dielikov sa 
zobrazuje, tým väè¹ia je intenzita signálu.

 a dieliky nad týmto symbolom.

- Udáva zostávajúcu energiu v batérii. Èím viac dielikov sa zobrazuje, tým viac 
energie e¹te zostáva v batérii.
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Ak chcete telefonova», zadajte medzimestskú predvoåbu a telefónne èíslo, a potom 
stlaète .

Hovor prevezmete stlaèením .

Hovor ukonèíte stlaèením . 

Výberové tlaèidlá
Prepína re¾im telefónu.

 Prechádzajú polo¾kami menu, submenu a nastaveniami. Ak nemáte 
aktívny hovor, mô¾ete posúvacie tlaèidlá pou¾i» na prechádzanie obsahom pamäti. 
Poèas aktívneho hovoru mô¾ete pomocou posúvacích tlaèidiel upravi» hlasitos».

 -  Tlaèidlá pre zadávanie èíslic a písmen. Odkazovú schránku zavoláte 
stlaèením a pridr¾aním .

 Vyu¾íva sa v ¹peciálnych funkciách. Ak ste si predplatili dve telefónne 
linky, mô¾ete medzi nimi prepína» stlaèením a pridr¾aním . 

 Funkcia týchto dvoch výberových tlaèidiel závisí od textu, 
zobrazeného v spodnej èasti displeja.

Poznámka: Slúchadlo a mikrofón sa nachádzajú na zadnej èasti zariadenia.
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 Nokia Wireless Data Forum je WWW slu¾ba pre tretie strany, ktoré vyvíjajú 
aplikácie a slu¾by pre platformy Nokia. WWW stránky fóra poskytujú informácie o 
rozlièných mo¾nostiach vývoja ako aj o marketingovej podpore pre vývojárov, 
systémových integrátorov a ïal¹ích partnerov spoloènosti Nokia.

Nokia Wireless Data Forum okrem toho ponúka produktovú podporu pre Nokia 
9210 Communicator a ïal¹ie bezdrôtové dátové produkty spoloènosti Nokia. 
Nájdete tu dokumenty, ovládaèe, struèné návody, informácie o otázkach 
kompatibility atï. 

Pre záujemcov o dátové prenosy v mobilných sie»ach nájdete na WWW stránkach 
fóra dokumenty o rozlièných technológiách, súvisiacich s bezdrôtovým prenosom 
dát.

Nokia Wireless Data Forum nájdete na adrese http://www.forum.nokia.com.

Club Nokia
V Clube Nokia nájdete v¹etko, èo potrebujete k optimálnemu vyu¾itiu svojho 
telefónu Nokia. Ako èlen Clubu Nokia máte nárok na veåké mno¾stvo exkluzívnych 
výhod. Medzi ne patria expresné slu¾by a podpora, neoficiálne premiéry nových 
produktov Nokia, ¹peciálne prioritné ponuky, prístup na WWW stránky Clubu Nokia 
a e¹te oveåa viac.

S va¹imi otázkami vám pomô¾e jeden z na¹ich ¹pecialistov na telefóny Nokia. 
Získate jednoduchý prístup ku Club Nokia Careline, ná¹mu telefonickému centru 
podpory produktov. Získate tie¾ jednoduchý prístup ku Club Nokia Instant Services, 
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ená¹mu servisnému stredisku, ponúkajúcemu v¹estranné slu¾by v¹etkým 
registrovaným èlenom Clubu Nokia. Servisné miesta Clubu Nokia nájdete v celej 
Európe. 

Prístup ku v¹etkým slu¾bám Clubu Nokia, ako aj k informáciám o produktoch, 
¹peciálnym ponukám, správam o nadchádzajúcich podujatiach a sú»a¾iach získate 
rýchlej¹ie a jednoduch¹ie cez WWW stránky Clubu Nokia. Club Nokia je otvorený 
pre èlenov z väè¹iny európskych krajín - staòte sa jeho èlenom e¹te dnes. Club 
Nokia nájdete na adrese http://www.club.nokia.sk.
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Tip: Originálne 

príslu¹enstvo Nokia pokrýva 
najrozmanitej¹ie u¾ívateåské 
prostredia: moderné 
vybavenie pre prenosy dát, 
praktické headsety, 
nabíjaèky a dr¾iaky pre 
mobilné pou¾itie i pre 
pou¾itie v kancelárii.

Originálne príslu¹enstvo Nokia je zárukou najlep¹ích prevádzkových parametrov 
vá¹ho mobilného telefónu Nokia v rozmanitých podmienkach. Príslu¹enstvo pre 
Nokia 9210 Communicator bolo vyvinuté pre rozlièných u¾ívateåov a komunikaèné 
potreby.

Poznámka: Pou¾ívajte výluène batérie, nabíjaèky a príslu¹enstvo, schválené 
výrobcom komunikátora pre tento konkrétny model komunikátora. 
Pri pou¾ití akýchkoåvek iných typov sa anulujú v¹etky povolenia a 
záruky, vz»ahujúce sa na komunikátor, a vystavujete sa 
nebezpeèenstvu.



©2001 Nokia Mobile Phones. All rights reserved. 

38
N

áv
od

 k
 p

rís
lu

¹e
ns

tv
u Batérie, nabíjaèky a stojany

Vysokokapacitná batéria BLL-3

Obrázok 13

Vysokokapacitná batéria BLL-3 je tenká a trvanlivá 1300 mAh lítium-iónová 
batéria s veåkou výdr¾ou. V závislosti od spôsobu pou¾ívania vám táto batéria 
zabezpeèí hovorový èas 4-10 hodín a pohotovostný èas 80-230 hodín.

Nokia 9210 Communicatora vá¾i s touto batériou je 244 g.



©2001 Nokia Mobile Phones. All rights reserved.

39

N
áv

od
 k

 p
rís

lu
¹e

ns
tv

uVýkonná cestovná nabíjaèka ACP-9

Obrázok 14

Tip: Táto nabíjaèka je 
zvlá¹» vhodná pre åudí, ktorí 
trávia veåa èasu na cestách.

Výkonná cestovná nabíjaèka ACP-9 je åahká a trvanlivá nabíjaèka, ktorá pracuje 
s väè¹inou sie»ových napätí. Poèas nabíjania mô¾ete komunikátor normálne 
pou¾íva». Pri pou¾ití tejto nabíjaèky je èas nabíjania komunikátora pribli¾ne 180 
minút (v závislosti od stupòa vybitia batérie).

Európska verzia Verzia pre Spojené 
kráåovstvo (UK)
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Tip: Ak chcete pomocou 
tohoto dr¾iaka nabíja» 
batérie, potrebujete 
Výkonnú cestovnú nabíjaèku 
ACP-9. Pre prepojenie 
s poèítaèom PC potrebujete 
kábel adaptéra DLR-2L/RS-
232. Pre prepojenie s 
poèítaèom PC mô¾ete vyu¾i» 
aj infraèervený port.

Obrázok 15

Roz¹írený stolový dr¾iak DCH-10 poskytuje praktický spôsob, ako
• nabíja» batériu, keï je komunikátor pripojený k dr¾iaku
• pripája» sa ku kompatibilnému poèítaèu PC pre prenos dát.

Stojan má na åavej strane infraèervený port; pozrite si Obrázok 15. Stojan má tie¾ 
¹trbinu pre nabíjanie batérií oddelene od komunikátora; to je zvlá¹» praktické pre 
nabíjanie náhradných batérií. 

Nabíjanie batérie komunikátora cez stolný dr¾iak

1 Zapojte do dr¾iaka Výkonnú cestovnú nabíjaèku ACP-9.
2 Umiestnite komunikátor (s osadenou batériou) do stolného dr¾iaka, stranou 

s konektormi napred.
3 Zapojte nabíjaèku do sie»ovej zásuvky.

nabíjacia ¹trbina pre 
náhradnú batériu

infraèervený port
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1 Zapojte do dr¾iaka Výkonnú cestovnú nabíjaèku.
2 Zasuòte náhradnú batériu do druhej ¹trbiny, zlatými kontaktmi napred. Najskôr 

zatlaète batériu nadol, potom ju zåahka potlaète dozadu, kým nezapadne na 
miesto.

3 Zapojte nabíjaèku do sie»ovej zásuvky. Skontrolujte, èi svieti kontrolka na åavej 
strane stojana. Èervené svetlo oznamuje, ¾e prebieha nabíjanie. Po nabití 
batérie sa rozsvieti stále zelené svetlo.

4 Batériu vyberiete tak, ¾e ju posuniete dopredu, potom ju nadvihnite a vyberte 
zo stojana.
Poznámka: Ak sa v stolnom dr¾iaku súèasne nabíja aj komunikátor, nabíjanie 

náhradnej batérie sa preru¹í, kým sa úplne nenabije batéria, 
pripojená ku komunikátoru.

Prepojenie s poèítaèom PC

Jedna z mo¾ností prepojenia s kompatibilným poèítaèom PC je vyu¾i» Kábel 
adaptéra DLR-2L/RS-232, a to nasledujúcim spôsobom:
1 Zapojte adaptérový kábel do konektora na zadnej strane dr¾iaka.
2 Druhý koniec kábla zapojte do poèítaèa. 
3 Umiestnite komunikátor do dr¾iaka, stranou s konektormi napred.
4 Na poèítaèi spustite buï program PC Suite for Nokia 9210 Communicator alebo 

aplikáciu Fax/Modem.

Druhou mo¾nos»ou je vyu¾i» infraèervené prepojenie; v tomto prípade postupujte 
takto:
1 Skontrolujte, ¾e na komunikátore i na poèítaèi sú aktivované infraèervené porty. 
2 Umiestnite komunikátor do dr¾iaka, stranou s konektormi napred.
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Vzdialenos» medzi oboma portmi by nemala presiahnu» 30 cm.
4 Na poèítaèi spustite buï program PC Suite for Nokia 9210 Communicator alebo 

aplikáciu Fax/Modem.

Synchronizáciu dát medzi komunikátorom a organizátorom, be¾iacim na 
kompatibilnom poèítaèi PC, mô¾ete vykona» jediným stlaèením tlaèidla . Viac 
informácií nájdete v návode na pou¾itie programu PC Suite - PC Suite Guide - 
v oddieli Pou¾ívame Nokia 9210 Communicator (Using Nokia 9210 Communicator) 
na disku CD-ROM, ktorý je súèas»ou predajného balenia.
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Roz¹írená súprava do auta CARK109

Obrázok 16

Tip: Nabíjacie èasy 
batérií sú rovnaké ako u 
Výkonnej cestovnej 
nabíjaèky ACP-9. 

Roz¹írená súprava do auta CARK109 poskytuje praktické doplnkové handsfree 
vybavenie do auta. Súprava zabezpeèuje aj nabíjanie komunikátora. Automobilovú 
súpravu musí in¹talova» kvalifikovaný personál. 
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Obrázok 17

Súprava pozostáva z Roz¹íreného aktívneho dr¾iaka do auta CRM-1 (je zobrazený 
na Obrázku 17), Roz¹írenej jednotky súpravy do auta HFU-2, mikrofónu HFM-8 a 
Externého reproduktora súpravy HFS-12. Okrem toho mô¾ete ako doplnky vyu¾i» 
Externé slúchadlo HSU-1 pre zvý¹enie súkromia a Anténnu súpravu AMD-2 pre 
zlep¹enie príjmu a zvý¹enie dosahu (obe súèasti sa dodávajú osobitne). 

Umiestnenie komunikátora do dr¾iaka

1 Zatvorte kryt komunikátora a otoète anténu do zlo¾enej polohy.
2 Vlo¾te komunikátor do automobilového dr¾iaka, stranou s konektormi napred.
3 Aby ste nepo¹kodili konektory, jemne zatlaète komunikátor nadol, kým ho 

bezpeène nezachytí uzamykací mechanizmus.

Volanie pomocou automobilovej súpravy

1 Navoåte po¾adované èíslo pomocou tlaèidiel alebo vyhåadajte príslu¹né meno a 
èíslo s vyu¾itím vyhåadávacej funkcie.

2 Stlaète . Ak sa chcete zhovára» dôverne, zdvihnite externé slúchadlo, 
pokiaå ho máte in¹talované.

Prijatie hovoru

1 Stlaète , alebo, ak máte in¹talované externé slúchadlo, zdvihnite ho.
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komunikátor bude prijíma» prichádzajúce hovory automaticky.

Prechod od externého slúchadla k hlasnému hovoru

Jedenkrát stlaète výberové tlaèidlo Mo¾nosti a do 5 sekúnd zlo¾te slúchadlo. 
Ak pred zlo¾ením slúchadla nestlaèíte tlaèidlo Mo¾nosti, hovor sa ukonèí.

Ukonèenie hovoru

Stlaète , alebo, ak máte in¹talované externé slúchadlo, zlo¾te ho.

Senzor zapaåovania

Funkcia senzora zapaåovania umo¾òuje automatické zapnutie a vypnutie 
komunikátora v¾dy, keï sa komunikátor nachádza v nabíjacom stojane a vozidlo 
na¹tartuje, resp. zhasne motor. To zabraòuje, aby komunikátor vybil batériu auta, 
ak ho nedopatrením necháte na dlhú dobu zapnutý.

Ak je senzor zapaåovania in¹talovaný, je v¾dy funkèný. Ak si neprajete aktivova» 
senzor zapaåovania, po¾iadajte svojho dealera, aby ho nechal nenain¹talovaný.

Po vypnutí zapaåovania sa na displeji zobrazí správa „Phone will power off, if not 
used’ (Telefón sa vypne, ak ho nebudete pou¾íva»). Komunikátor sa po 15 
sekundách vypne, ak pred uplynutím tohoto èasu nestlaèíte niektoré tlaèidlo alebo 
nevyberiete komunikátor z dr¾iaka.

Stí¹enie autorádia

Ak máte autorádio, podporujúce túto funkciu, dôjde poèas hovoru k stí¹eniu 
autorádia. Po¾iadajte svojho dealera, aby vám pri in¹talácii aktivoval funkciu 
stí¹enia autorádia.
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Ak je táto funkcia in¹talovaná, aktivuje elektromotor pohyblivej antény.

Nabíjaèka na mobilný telefón LCH-9

Obrázok 18

Nabíjaèka na mobilný telefón LCH-9 zabezpeèuje jednoduchý a praktický spôsob 
nabíjania batérie komunikátora vo vozidle. Je vhodná pre väè¹inu zásuviek pre 
automobilový zapaåovaè cigariet. Zapojte káblik nabíjaèky do spodného konektora 
komunikátora.
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Headset HDC-8L

Obrázok 19

Headset HDC-8L poskytuje slúchadlá a mikrofón pre zvý¹enie súkromia pri 
telefonovaní. Pomocou tlaèidla diaåkového ovládania, ktoré sa nachádza 
v mikrofónnej èasti headsetu, mô¾ete prija» a ukonèi» hovor. Headset sa pripája 
priamo ku konektoru v spodnej èasti komunikátora.
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Obrázok 20

Spona na opasok BCH-17 poskytuje praktický spôsob nosenia komunikátora, pri 
ktorom máte komunikátor stále pri ruke.

Transportné puzdro

Obrázok 21

Transportné puzdro je vyvinuté ¹peciálne pre Nokia 9210 Communicator. 
Dostanete ho u dealerov spoloènosti Nokia.
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Pamä»ová karta
Pamä»ová karta veåkosti po¹tovej známky je výmenným pamä»ovým médiom pre 
komunikátor. Pamä»ová karta zväè¹uje dostupnú pamä» pre dáta a softwarové 
aplikácie. Mô¾ete napríklad do komunikátora zavádza» nové aplikácie a uklada» 
súbory, ako obrázky, zvukové súbory, faxy a dokumenty. Pamä»ovú kartu mô¾ete 
pou¾íva» tie¾ pre rozlièné aplikácie a adresáre.

Poznámka: Pamä»ové karty, ktoré pou¾íva Nokia 9210 Communicator, nie sú 
kompatibilné s pamä»ovými kartami pre star¹ie modely 
komunikátorov Nokia, ale karty urèené pre Nokia 9110i 
Communicator mô¾ete po sformátovaní vyu¾íva» aj v modeli 9210.
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Obrázok 22

Tento univerzálny adaptérový kábel poskytuje praktický spôsob, ako prepoji» vá¹ 
Nokia 9210 Communicator v¾dy keï potrebujete prená¹a» dáta. Pripája sa 
k sériovému portu RS-232 kompatibilného poèítaèa. Mô¾ete ho pou¾íva» aj 
s Roz¹íreným stolovým dr¾iakom DCH-10.


